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Lesson 1: PowerPoint for Presentations 
 

Purpose 
PowerPoint is a powerful tool to create professional looking presentations and slide shows.  It is also a 
creative and efficient way to present posters.  Today we’ll talk about using PowerPoint to create 
presentations. 
 
Today you will create a first draft of the presentation for your term project. Divide yourselves into pairs. 
Each pair should have one person who attended previous PowerPoint presentations.  The person with 
LESS experience with PowerPoint should be the one running the program.  
 
Prerequisite  
No prerequisite are required to start this lesson. 
 

Part I: View Examples 
 
Look at a few examples of PowerPoint presentations. These are on the BarchardsLab cluster server, under 
Project Examples.  Open the folder called Example Presentations.  Open one or two of these 
presentations.  For each, click through the presentation, to get a sense of what your presentation is going 
to look like when it is done. 
 

Part II: Tips for Creating a Spoken Presentation in PowerPoint 
 
1. Your presentation will have many slides, perhaps 10 – 30 slides. 
2. Your first slide must be a title page, with the name of your presentation, and all author names.  Use 

the correct publication names for each author. 
3. Every slide must have a title.  The title might be the same for several slides in a row. 
4. Use point form.  Probably the only time you will need a full sentence is when defining your 

constructs, during the Introduction. 
5. If there is something that you will have difficulty remembering and you think it is really important to 

say, put it on a slide.  Do not refer to a piece of paper to help you remember it.  By putting it on a 
slide, this will help you maintain your interaction with the audience – you will only be looking at 
your audience and the slides that your audience is looking at. 

6. The purpose of the slides is to help the audience keep track of where you are in your presentation, to 
help you illustrate the point you are trying to make, and to provide you with memory aids to help you 
remember where you are.  You should NOT read your slides word for word. 

7. For most slides, most of the slide should be blank.  The ideal slide will have been 10 and 20 words on 
it. 

8. Do not put your references on a slide. 
9. You do NOT need to put everything into your presentation.  You probably will NOT be able to say 

your entire project during the time limit.  Include the most important and most interesting material 
and skip the rest. 

 
Part III: Create Rough Draft Presentation of Current Term Project 

 
1. Open Microsoft PowerPoint.  Click on the Start button, then proceed to Programs, then from there 

highlight Microsoft Office or it could be labeled as Microsoft Products, and finally drag your mouse 
and click on Microsoft Office PowerPoint. 

2. When the PowerPoint program has opened, a new slide will appear. This should be the Title Slide.  
Click on where it says to “click to add title” and type the title of your poster.  On the bottom, labeled 
“subtitle”, type in the names of your poster team members. 



3. After making the title page of your presentation, add a new slide where you can begin to place the 
contents of your paper.  In order to add a new slide, click on the Insert tab, and select New Slide. 

4. A new Title Slide layout will appear and on the right side of the screen, you should see the different 
types of slide layouts available.  To replace the Title Slide layout, double click on a different slide 
layout.  (You can also choose a different slide layout by clicking on the arrow that appears when you 
are on the layout style. Simply click on the arrow and then click on Apply to Selected Slides.)  Under 
the Text Layout choose the Title layout. 

5. On the second slide, you will begin to add the content of your project. Begin with the introduction. 
Type the word Introduction on the title section of your slide.  On the text space provided (subtitle), 
type words or phrases that summarizes the contents of your introduction.  For the introduction, it is 
important that you create a list of important points, because we will animate that list later. 

6. Outline the rest of your project on other slides.  You will need one or more new slides for Method, 
Results, and Conclusions. 

7. Add and choose a slide design.  Click on Format, then Slide Design. Select a design you wish to 
apply.  Make sure it is appropriate for your slide contents and layouts.  Note: The slide design looks 
different on different slide layouts.  Look at the thumbnail slides on the left while you try different 
designs. To add a slide design, follow the same steps you would to add a slide layout in step 4. 

8. Next you will animate the list in your introduction, so that one point shows up at a time.  To create 
animation, click Slide Show, then Custom Animation.  Click on the word or phrase you wish to 
animate.  Then on the custom animation box, click on Add Effect. From the drop down menu, place 
your cursor on Entrance, and then choose the type of effect you want (Blinds, Box, etc.).  If you 
choose to remove the effect or change it, simply click on the word or phrase in the custom animation 
box and then click on remove.  Continue to choose and click different words or phrases on your slide 
to animate.  The custom animation will show a list in the order of when the words and phrases will 
appear in your slide show.   

9. To see what your final presentation looks like, watch the slide show.  Click on Slide Show, View 
Slide Show.  This is also how you will present your presentation, during the final class of the 
semester.  If you see anything in the Slide Show that you do not like, change it. 

10. If you have time, try to create a rough draft of your entire presentation.  You will need to change it 
later, once you have had more feedback on your poster, but it will be easy for you to make those 
changes later. 



Lesson 2: PowerPoint for Posters 
 
Purpose  
After completing and polishing your poster, you need a way to creatively and effectively display it - 
whether in an academic setting or at a conference.  One way to do this is to print out your formatted 
paper, and paste it on sheets of colored construction paper.  While this is a perfectly acceptable method, 
creating a large poster in PowerPoint is a more professional (and increasingly more common) way to 
present your research. Compare your poster to other posters around the lab. 
 
Prerequisites 
You should have successfully completed Lesson 1: PowerPoint for Presentations, before attempting this 
lesson. 
 
Layout  
1. Open Microsoft PowerPoint . 
2. Choose a blank layout slide design. 
3. All poster content should fit on one slide.  It should be 4 feet tall by 3 feet tall; this gives you enough 

room to stand beside it at a conference.  Go to File and click on Page Setup. Under Width, type in 48 
inches. Under Height, type in 36 inches. 

4. There must be a minimum of ½ inch margin on every side.  If not, when you print it, your writing will 
be cut off.  This will be a very expensive mistake at the time. 

5. Usually, the poster will be divided into three sections. To do this insert a table with three columns. Go 
to Insert  and click on Table. Under number of columns, type in 3. Under number of rows, type in 1. 
Click Ok. To enlarge the table, click and drag on the circles surrounding the table. 

6.  In these columns, add the Introduction, Methods, results, and Conclusion section of your poster. 
7. Insert a text box above your table. Go to Insert and click on Text Box. Position your mouse on the top 

left hand corner, click and drag the box across to the right hand corner.  
8. Use a larger size font, like 48 point. Go to Format and click on Font. Under size, type 48. 
9. Type the title of your poster, name of the institution, and the names of your group members in this 

text box. You can also add small graphics, or the logo of the school at the top as well. Logo: use 
google search (images) for UNLV logo or copy and paste from previous posters. 

10. To change the borders of the table right click on the table and click on Borders and Fill. Under 
Borders, click on the different colors, styles, and choose the width you’d like. Under Fill, click a color 
that you would like. 

11. To add a background to your entire poster, click on Format and then Background. Click on the drop 
down arrow and choose from the menu. For more choices, click on more colors or fill effects. 

 
Content 
This is a fairly subjective process.  Most students just eyeball it, and add spaces or increase/decrease font 
size as needed.  Also, some prefer to keep the section titles part of the text, while others like to add a 
separate text box/colored box in between the sections themselves.  By now, you’ve learned to do enough 
creative things in PowerPoint to be able to decide which would suit your poster better.   



Lesson 3: Inserting Tables into PowerPoint and more 
 
Purpose 
In this lesson you will learn how to insert tables into PowerPoint. Furthermore, we will show you several 
techniques on making an appealing presentation. These techniques include the following: creating your 
own template, using autoshapes, inserting a Sound clip, and creating a transparent background. 
 
Prerequisites  
You should have successfully completed Lesson 1: PowerPoint for Presentations, before attempting this 
lesson. 
 
To insert a table into PowerPoint 
1. Open PowerPoint and create a new presentation. 
2. Open Microsoft Excel and create a new workbook. 
3. Open Microsoft Word and create a new blank document. 
4. Working in word, make a results-section-type table. 

a. A table like the one below should be sufficient. 
 
Table 1 
Correlations with Hand-Scoring 
POES method Correlation 
All-sum .92 
Highest 4 .91 
334 .82 
3345 .78 
p < .05. 

 
b. Formatting is not an issue at this point; by the time we paste it into excel, the formatting will be 

lost.   
c. For now, just make sure your table has “Table 1” as the first line, a title for the second line, and at 

least 5 columns and 2 rows.  The table below is in APA format – this exercise has the added 
benefit of familiarizing you with APA formatting. 

d. Leave the line width/appearance the same for now. 
5. Select the table in it’s entirety (click and drag, or press ctrl – a to select all) 

a. Press ctrl-c to copy the table 
b. Go back to Excel 
c. Select a cell near the middle of the screen (like C6 or so).  This ensures that you can fully see the 

table – if you just paste the table, the top and left edges won’t be visible to you. 
d. Press ctrl-v to paste the table.   

6. Format the table so it complies with APA standards.   
a. Mostly, this will entail changing the borders around the table itself so that no vertical lines are 

visible (Word greys the lines out, instead of completely erasing them – thus the example table 
looks odd).   

b. Also, horizontal lines separating the actual data should also be removed.   
c. In the example, only the topmost line, the bottommost line, and the line under POES 

method/Correlation should be visible. 
d. Center the correlations. 

7. Copy this table once you are satisfied with the formatting. 
a. Select all cells that contain the table 
b. Press ctrl-c to copy  

8. Now, go to PowerPoint 



a. In PowerPoint, click edit, paste special, enhanced metafile.   
b. This pastes the table like a jpeg/image.   
c. You can now click the table and resize or move it as needed, without having to reformat 

everything. 
 
Jazzing up your slides 
 
Creating your own template 
1. If you want to create a presentation with a unique appearance, start with a blank presentation. To open 

the blank presentation, click New on the File menu. 
2. Click on View / Master / Slide Master. The blank presentation will already have a title box and a 

bullet text box. First we will change the type font to Ariel and the style to Italics in the Title box. 
Click the dashed line of the title box with your mouse. Click again. When the line changes to a broad 
hash mark, click on the font box and select Arial and change the style to Italics.   

3. Change the text box to straight Arial using the same process.  
4. Now let's create a new color scheme, add different bullets and add a graphic as a background. From 

Format, choose Background and then click then click the drop down menu from Background 
fill. Choose a color to match your mood.  

5. Change the Text and lines to white and change the Title to a bright yellow. Leave the remaining 
elements as they are and click on Apply to All.   

6. Now let's give the background a little more pizzazz. From Format, choose Background. Under 
Background Fill, click the blue rectangle under the miniature of the slide. Select Fill Effects.   

7. Under Colors, select 2 colors. Under Shading Styles, select Diagonal Up, and choose the left hand 
bottom version. You should see a lighter color in the middle with the darker color going diagonally 
on the upper left and lower right quadrants of the slide. If you don't like that Shading style, choose the 
one you want.   

8. You could also click the Pattern tab and select one of the many styles available here.   
9. Add a picture by clicking the Picture tab, locating the picture and adding it. Note: you may alter the 

background colors by adding a graphic, so do so carefully.   
10. If you don't want to enter a picture, perhaps you want to add a shape from the Drawing Toolbar's 

Autoshape tool. 

Using autoshapes 
1. To add special shapes like lightning bolts and smiley faces go to Insert / Picture / Autoshapes. This 

will open the autoshapes dialog box.  
2. Choose the third autoshape over which is called Basic Shapes. Clicking on this will give you a drop 

down menu in which you can choose the basic shape of your liking. 
3. Move the mouse cursor to your slide, click and drag to form the shape you chose.  Click on the 

corners to adjust the size, or click in the middle to move it to a new location. 
 
Inserting a Sound clip 
1. Insert / Movies and Sounds / Sound from File  Use the file sttng.mid found in BarchardsLab / Lab 

Meetings and Training / Workshops on PowerPoint / sttng.mid 
2. PowerPoint will prompt you to decide how your movie should play i.e. automatically or only when 

you click on it.   
3. The sound will appear on the slide as a speaker. To reposition the speaker, click and drag it to a new 

position.   
You can click to start/stop the sound file. 

 
 
 



Creating a transparent background 
To make your slides or poster unique, you can use pictures.  Pictures can be overpowering, and can use a 
lot of ink.  Therefore, in this section you will learn how to use a transparent picture as a background. 
1. Open a new blank PowerPoint presentation 
2. Insert a picture.  Use Insert, Picture, then navigate to your picture, and click Insert. 
3. Click Format, Picture 
4. On the Picture tab, in the section that says Image Control, click on the drop-down menu next to Color.  

Select Washout.  Click OK.  You now have a transparent picture. 
5. Right click on the picture, and select Save as Picture.  Navigate to your desired location, give your 

file an appropriate name, and click Save. 
6. Open your real presentation. 
7. Click on the Format menu, and select Background. 
8. Under the Background fill box, there is a drop-down menu.  Click on this.  Select Fill Effects. 
9. Click on the Picture tab, and then click on Select Picture. 
10. Navigate to your picture, select it, and click on Insert.  Click OK. 
11. If you want this as the background for ONE slide, click Apply.  If you want this as the background for 

ALL slides, click Apply to All. 
12. Save your presentation. 


